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Operating Systems with Windows NT 
 

 
 
Lab - 1 (4 Real time hours) 

 
NT-Server - Installation Steps 
 
The installation (or just install) process is divided into various steps or 
procedures. First of all is the text (or DOS) phase, which copies files and 
establishes a boot-up facility on floppy disks or the hard drive. The second 
phase (the so-called GUI phase) actually loads the drivers and runs in the true 
Windows NT phase. The following steps explain the basic installation 
procedure: 

 
1. The initial part of the text mode involves booting into the installation 

process. There are several ways to accomplish this. The most obvious is 
booting from the install floppies. Likewise you can access the installation 
CD from the DOS prompt and start the installation by running WinNT  (or 
WinNT /b, which copies the boot files to a hard drive rather than floppy 
drives) from the I386 director. If  you are upgrading the installation from 
Windows NT 3.51, you can run winnt32 in the same manner. Likewise, 
you can run WinNT or winnt32 with /u to perform an install in 
unattended mode. 

 
On RISC-based machines, the install process is somewhat different. For 
example, NT is installed onto Alpha-based machines by running 
applications directly from the CD (and you don’t use switches as /b). 
These differences will be detailed in the appropriate sections. 
 
The setup will run automatically and will boot onto the install CD if the 
system BIOS supports this feature. If an install CD is not found (unless 
you are running the winnt or winnt32 methods from an install directory) , 
the install will abort after Disk 3. 
 

2. When given the choice between Default and Custom, choose Custom 
Install Method. This option enables you to see and select the application 
that are being installed. 
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3. Verify the system components that the detection procedure summarizes 

for you. If the list is incorrect, restart Setup. When the system displays the 
message Setup is inspecting your computer’s hardware configuration, 
press F6. This action should allow you to bypass autodetection of the 
hardware; you can then indicate the components that are present. (At this 
point, you can also install legacy SCSI drivers, etc.) 

 
4. You will be asked to choose file formats. Many people suggest that you 

have a small FAT partition as drive C: so that you can do file maintenance 
via DOS. 
 
However, installing a FAT partition is a violation of C2 security(if that’s 
important to you). Use NTFS wherever possible, especially with modern 
large drives (greater than a gigabyte). 
 

5. If the drive has not been formatted, you will be given the opportunity to 
partition and format the drive. Even if you ask for NTFS, the initial format 
is FAT and then it is subsequently converted to NTFS on the next reboot. 
 

6. Select the directory to which NT will be installed. Using the default name 
(winnt) is a good idea (you can change the drive). 
 

7. Enter your name and your company name. 
 

8. Enter the Administrator password. This is very important. Choose a 
password that’s at least seven characters long and has a nonsense symbol 
in it. 
 

9. Supply a unique name for the computer – that is, a name that does not 
exist elsewhere in the network or domain. 
 

10. When the network portion of the install continues, you are given the 
following choices: 
 
• Do not connect the computer to the network at this time. 
• This computer will participate on a network via(default); 
• Wired directly to a network via ISDN or a standard network cable. 
• Remote access via a standard modem. 
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This is a marked change from previous setups and reflects the new wizard 
incorporation. Unless you have prior knowledge of a problem with a 
network interface card(NIC), there should be no problem  joining a 
network. On the other hand, there are cases where NT is installed and 
crashes only when the network driver is initialized. A server needs an 
NIC. If there are suspected problems, install the Msloopback  adapter, 
after NT is running , install the NIC . If you know that the NIC is okay, 
continue with the installation process. 

 
11. Now we come to our first serious choice. What NIC is on the server? By 

the way, a server by definition must have a network card or other means 
of providing for “service”. For some NICs ,  autodetection , detect the NIC 
manually. 

 
12. Choose the networking protocol. The install defaults to IPX/SPX and 

NetBEUI. 
 
The former is needed if you are using interconnectivity to a Novel 
network. The latter works well in a Microsoft environment. My choice, 
however, is TCP/IP, because it is the fastest growing of the protocols. If 
you do choose a TCP/IP protocol, you are asked if you have Dynamic 
Host Configuration  Protocol (DHCP) to install or connect  to. This of 
course is dictated by the network environment into which the machine is 
being installed. 

 
13. The server installation defaults to installing as a Primary Domain 

Controller(PDC). You can set up the installation as a Backup Domain 
Controller(BDC), but this option presupposes the existing presence of PDC 
on the network. Finally, you can install as a standalone server. 

 
14. When asked to determine the time zone you are in, set the system 

information accordingly. 
 

15. The final issue of note is establishing the video configuration. This is easier 
in Version 4.0 than in previous version. You simply select the resolution 
you want. You will be asked to reboot. After rebooting, you can change 
the resolution on-the-fly, but changing to a larger font, etc., requires a 
reboot. 
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Lab - 2 (4 Real Time hours) 

 
Ex 1       Logon Process                                                

 
1. When Windows NT starts getting loaded and the Begin Logon dialog box 

will be displayed. 
 
2. Keep the <Ctrl> and <Alt> keys pressed and then press <Delete> key 

once. The logon information dialog box gets displayed With 
Administrator as user name and the default domain name. 

 
3. Password in Windows NT is case sensitive , therefore make sure that the 

characters typed are all in capital letters. If you click the right password 
Windows NT displays a graphic user interface that is very similar to that 
of Windows 95 interface. 

4. Click on the Start button. 
 

5. Click on the Program menu. 
 

6. Point the mouse pointer on Administrative Tools. 
 

7. Windows NT pops up another sub menu as shown in Fig. 

 
 
8. Click on the User Manager for Domains option. 
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The User Manager Window gets displayed in the screen as shown in Fig. 
 

 
Ex 2  Create User Accounts 

 
1. Click on the User menu. 
2. Click on New User option as shown in Fig. 

 
Windows NT displays New User dialog box as shown in Fig and cursor is 
placed in the Username box.     
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Administrators on the primary domain controller (PDC) and backup domain 
controller(BDC) cannot make the same user as the database directory of one 
gets replicated to another. As a result, the administrator on PDC computer 
will create users – Charles, Alan and James ( do the steps 3 to 14) where as the 
administrator on BDC computer will create users – Patrick,  Brian and 
Richard (do the step 15 using steps 3 to 12) 
 
Steps for Administrator on PDC: 
 
3. Type the username as “Charles”. 
4. Press<Tab> to move to Full Name box. 
5. Type “Carter Charles”. 
6. Press <Tab> to move to Description box. 
7. Type “Working as Senior Executive – Technical”. 
8. Press “Tab” to move to Password box. 
9. Type “password” 
 
The text you type will be displayed as stars, as a result you will not be able to 
view what you are typing, therefore care has to be taken accordingly 
Passwords are case sensitive. 
 
10. Press “Tab” to move to Confirm Password box. 
11. Type “password” 
 
Your screen must look the one as shown in Fig. 
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12. Click on the Add button. 
 

 
Notice that the Cancel button below the Add screen has changed into Close 
button and New User window gets refreshed. 
13. Create the below given user accounts with respective details. 
 

Userna
me 

Full Name Description Passwor
d 

Confirm 
passwor

d 
Alan Deigo Alan Vice 

President 
passwor
d 

password 

James Neihaus 
James 

Manager passwor
d 

password 

 
14. Click on the Close button after you have created all three user accounts. 

Steps for Administrator on BDC: 
 
15. Create the below given user accounts with respective details: 
 

Userna
me 

Full Name Descripti
on 

Passwor
d 

Confirm 
password 

Patrick Adams 
Patrick 

Chairman passwor
d 

password 

Brian D’Costa 
Brian 

Executive passwor
d 

Password 

Richard King 
Richard 

Executive Passwor
d 

Password 
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Ex 3 

First you will have to create a home directory called Users, which must have 
share rights. 
 
1. Click on the Start button. 

2. Click on Programs menu. 

3. Click on Window NT Explorer. 

4. Click on the root directory. 

5. Click on the File main menu, click on the New option. 

6. Click on the Folder sub option. 

7. Type “Users” and press <Enter> 

8. Right-click on the Users folder, a menu drops down. 

9. Click on the Sharing option, the folder properties dialog box gets 

displayed. In this case the title of the window will be Users properties as 

shown in Fig. 

 
10. Click on the Shared As radio button : The share name box gets filled with 

the folder’s name as shown in Fig. Notice that the Apply button gets 
highlighted. The Apply button is pressed prior to OK button only when 
you want to change some other settings before you press the OK button. 

 
11. Click on the OK button  :  Notice that a small hand appears below the 

folder Users indicating that the folder has been shared. 
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12. Click on the File main menu :  Click on the Exit option. The Windows NT 

explorer will close. 
 

 
 
13. Click on the “User Manager – NT-LAB” on the taskbar. 

14. Click on the user account – Alan to select it. 

15. Click on the User main menu and click on properties as shown in Fig. 
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16. Click on the Profile button as shown in Fig.                
 

 
 
Windows NT displays a dialog box called User Environment Profile as shown 
in Fig.               
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17. Click on the Connect radio button, Z: appears automatically which will be 

used for the users to get connected to the server. 
In case, the Z: does not appear, click on the drop down button and select 
Z: 

 
18. Click on the To box and type “\\nt_server2\Users\%username%” 

Here nt_server2 is the name of the computer. Users is the share folder 
name and %username% is a system defined variable for the username. 
 

19. Click on the OK button. 
Similarly to assign home directories for Charles and James together do the 
following steps. 
 

20. Click on the OK button to close the user properties dialog box. 
 
21. Click on Charles user name. 
 
22. Keep the <Ctrl> key pressed and then Click on James username. 

Notice that both get selected as shown in Fig. 
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23.  Notice that both get selected as shown in Fig.              
 

 
 
24. Click on the Profile button as shown in Fig               
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25. Repeat steps 17 to 20 

 
26. Open the Windows NT Explorer to verify whether the home directories 

have been created .The users folders should look like as shown in Fig. 
 

 
 
 
 
 

Ex 4   Set Logon Hours Restriction 
 
1. Select all three users i.e. Alan, Charles and James with the help of <Ctrl> 

key. 
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2. Click on User main menu. 

3. Click on Properties option. 

4. Click on the Hours button. 

 
A logon hours dialog box is displayed on the screen as shown in Fig.      

 

 
 

The above calendar displays the number of hours the users can work in a 
week. The calendar starts at 12.59AM to 12.59PM. The dotted box placed in 
the first row and first column position is used for restricting the hours . 
Restrict the working hours of the users to your lab session hours. In this case 
we will be restricting the users to work between 11 am to 1 pm. 

 
5. Click on the first box and drag it to the last box in the Sunday row as 

shown in Fig.           
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6. Click on the Disallow button. You will notice that the thick line going 

across the boxes has been deleted indicating that the users cannot access 
the server on Sundays as shown in Fig. 

 
7. Similarly, disallow users from midnight to 11am and 1 pm to midnight as 

shown in Fig. 
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Ex 5 Set Workstation Restrictions 
 
1. Click on the Logon-To button Logon workstation dialog box gets 

displayed on the screen as shown in Fig.    
 

 
 

8. Click on the Users May Log Onto These Workstations radio button. 
Note that all the numbers become highlighted. 

 
9. Click in the first box. 
 
10. Type the name of your computer. In this case, type “nt_server2” as shown 

in Fig. 
 
11. Click on the OK button to close the Logon Workstation dialog box.                     

 

 
Set Account Restriction 
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1. Click on the Account button. The account information dialog box gets 
displayed on the screen as shown in Fig.  
 

  
 

2. Click on the End of radio button. Notice that Windows NT adds 30 days to 
your system date and displays it in the end of date box. The date is 
displayed in the American format i.e. mm/dd/yy. This date value can be 
changed. 

 
3. Click on the OK button to close the account information dialog box. 

 
 Test the user log on   

 
1. Click on the User main menu and then click on Exit option to close the 

‘User Manager for Domains’ dialog box. 
 
2. Click on the Start button. 
 
3. Click on the Shutdown option. The Shutdown dialog box appears on the 

screen . 
 
4. Click on the last radio button i.e. Close all programs and log on as 

different user?. 
 
5. Click on the Yes button. Windows NT closes all the programs open and 

displays the Begin  logon dialog box on the screen . 
 
6. Keep the<Ctrl> and <Alt>keys pressed and then press <Delete> key 

once. 
 



 
 
 
 
Operating Systems with Windows NT 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 18 
 

7. Click in the Username box and delete the user name Administrator. 
 
8. Type “Alan”. 
9. Press <Tab> to move to the password box. 
 
10. Type “password” , Note that all characters should be in small case 

because this was the format in which we had given the password. 
 
11. Click on the OK button so that Windows NT starts authenticating Alan’s 

account. Windows NT prompts with a logon message as  “The local 
policy of this system does not permit you to logon interactively”  

 
 The above message indicates that the users cannot work on the server 

machine. So as make the users work on the server locally, the 
administrator has to assign the ‘log on locally’ rights to the users. 

 
12. Click on the OK button. 

 
Granting User Rights Policy 

 
1. Click in the Username box. Delete the username “Alan”. 

2. Type “Administrator” and press <Tab> to move to password box. 

3. Type “hai” and click on the OK button. 

4. Open the User Manager for Domains utility. 

5. Click on the Policies main menu as shown in Fig. 

6. Click on the User Rights… option. The user rights policy dialog box 
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appears on the screen as shown in Fig. 

 

 
 
7. Click on the drop-down arrow of the Right box as shown in Fig. Scroll the 

list by the help of vertical scroll bar within the drop down list as shown in 
Fig.                 

 

 
 
8. Click on the ‘Log on Locally’ rights. Notice that those who can log on 

locally to the server are listed in the Grant To box as shown in Fig. 
 
9. Click on the Add… button. To add the users you just created. The ‘Add 

Users and Groups’ dialog box gets displayed on the screen as shown in 
Fig.            

 
10. Click on the ‘Everyone’ group from the Names box as shown in the Fig. 

 
All the users created come under the ‘Everyone’ group. If only some of the 
users have to be given rights for working on the server, then you will have 
to click the Show Users button to view all the users and select the user you 
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would like to give access to. The moment a user or group gets selected , 
the Add button gets highlighted. 
 

11. Click on the Add button. Note that the ‘Everyone’ group gets displayed in 
the Add Names box as shown in the below Fig. 

 

 
 

12. Click on the OK button to close the User Rights Policy dialog box.  Note 
that the ‘Everyone’ group has appeared in the ‘Grant To box’ as shown in 
the Fig. 
 

13. Click on the User main menu. 
 
14. Click on the Exit option to exit from ‘User Manager for Domains’. 
 
15. Click on the Start button and click on Shutdown option. This time the last option 

will be selected by default. 
 
16. Click on the Yes button to shut down the computer and log on as different 

user. 
 
17. Test the user logon of Alan. Windows NT displays a welcome screen as the 

user logs on for the first time as shown in Fig. 
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18. Click on the ‘Close’ button to close the Welcome Screen and proceed 

further. 
 
19. Open the ‘User Manager for Domains’. The user Alan will not be able to 

change or delete any settings done by the Administrator though he is able 
to view all of them. 

 
20. Try to access the properties of the use Alan. Windows NT displays an 

error as shown in Fig.                      
 

 
 

21. Click on the OK button. You will notice most of the options are either 
dimmed or they are not functioning. 
 

22. Try to delete any other user. Windows NT will display you the same error 
as ‘Access is denied’. 
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23. Open the Windows NT Explorer. Notice that at the end of folder’s tree a 
network folder gets attached as Z drive as shown in Fig. This indicates that the 
folders and profile you had created and assigned are working.  

 

 
 

24. Log Off and Log On as Administrator. 
 
25. Change the system time to plus one hour i.e. if current time is 1.00PM then 

make the system time as 2PM. 
 
The user does not have the privilege to change the system time as a result you 
will have to log on as administrator to change the system time. 

 
26. Log Off and Log On once again as Alan. Windows NT will deny access to 

the server by displaying the following message. 
 
“Your account has time restrictions that prevent you from logging on at 
this time. Please try again later.” 

 
Ex 6   Managing Trust Relationship with User Manager for Domains 

In order to establish a trust  relationship between two domains, follow these 
steps. 

 
1. If domain A wants  to trust users from domain B, an administrator in 

domain A should first add domain B to the list of domains it trusts. See the 
Fig for the Trust  Relationships dialog box. In this first action, if you were 
in domain A, you would add domain B to the Trusted Domains list. To do 
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this, click the Add button and then you will be prompted to enter the 
domain and a password, and to confirm the password. 

 
 
2. The administrator on domain B would have to use the same window to 

add domain A to its list of trusting domains. Click the Add button and 
then enter the password you obtained from the administrator of domain 
A. 

 
3. If you want to establish a two-way trust relationship, you would perform 

these first two steps on the opposite domain controllers. 
 

Note: 
 

You can establish trust relationships only between NT networked 
domains. LAN Manager 2.x clients cannot understand the trust 
relationships created by the preceding procedures . This is why they do 
not understand local groups. 

 
Lab - – 3 ( 2 Real time hours) 

 
Creating a Real-Time Chart 
 
In this exercise , you will set up a real-time chart and generate activity. 
 
• To enable disk counters 
 

1. Log on as Administrator, and in the Password box , type password. 

2. Click Start, point to Programs , and then click Command Prompt. 
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3. At the command prompt, type diskperf –y and then press ENTER.This 
step is necessary to enable monitoring of disk counters. 

4. Shut down and restart your computer. 

• To set up the chart 
 

1. Log on as Administrator, and in the Password box, type password. 

2. Click Start, point to Programs, point to Administrative Tools 
(Common) and click Performance Monitor. 

3. On the View menu, click Chart. 

 

 
 

4. On the Edit menu, click Add to chart.     
 

 
 
The Add to Chart dialog box appears. 
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5. Using the information provided in the following table, click the following 
counters that become available for the Memory, Physical Disk, and 
Processor Object. Click Add after each counter that you add. 

 
Object Counter Instance Description 

Memory Cache 
bytes 

Not 
Applica

ble 

Memory allocates as file cache. 

Memory Pages/Se
c 

Not 
Applica

ble 

The number of pages read from 
or written to disk to resolve 
memory references to pages 
that were not in memory at the 
time of reference. 

Physical 
Disk 

%Disk 
Time 

0 Percentage of time physical 
disk is busy. 

Physical 
Disk 

Avg.Disk 
Bytes/Re

ad 

0 Average number of bytes 
transferred from disk. 

Physical 
Disk 

Avg.Disk 
Bytes/W

rite 

0 Average number of bytes 
transferred to disk. 

Processo
r 

%Privileg
ed 

Time 

0 Percentage of processor time 
spent in Privilege Mode. 

Processo
r 

%Process
or 

Time 

0 Percentage of time processor 

Processo
r 

%User 
Time 

0 Percentage of processor time 
spent in User Mode. 

 
The graph appears, displaying the real-time activities of the memory, physical 
disk and processor objects. 
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• To generate chart activity 
 
1. With Performance Monitor still running, click Start, point to Programs, 

point to Accessories, and then click Calculator. 
 
2. Begin doing calculations.  This will generate CPU cycles. 
 
3. Close the Calculator. 
 
4. Return to the Performance Monitor Chart. 
 
5. Select the %Processor Time counter. Notice the %Processor Time average. 
 

 
 
Note: To highlight a specific counter on the chart, select a counter, and then 

press CTRL+H. 
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6. Minimize the Chart window. 

 
7. Load and minimize both Windows NT Explorer and the Disk 

Administrator. 
 

8. Return to the Performance Monitor Chart. 
 

9. Notice the activity , such as spikes, on the chart. 
 

10. Close Windows NT Explorer and Disk Administrator. 
 
Logging Processor Activity 
 
In this exercise, you will log information and then display the information in a 
chart. 

 
• To log information 
 
1. On the View menu in Performance Monitor, click Log. 
 
  

 
 

2. On the Edit menu, click Add To Log.           
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The Add To Log dialog box appears. 
3. In the Objects dialog box, hold down the CTRL key while you click 

Memory, Physical Disk, and Processor, and then click Add. 
 

4. Click Done.             
 

 
 

5. On the Options menu, click Log. The Log Options dialog box appears. 
 

6. In the File Name box type lab1.log          
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7. Under Update Time, click Periodic Update. 
8. In the Interval box, click 1, and then click Start Log.             
 

 
 

The Performance Monitor window appears, showing information on the log 
you are creating. Remember that when a log starts, all the counters for the 
selected object automatically begin recording data. 

 
9. Create processor activity by starting applications or moving the mouse. 
 
10. Collect at least 1 megabyte(MB) of data. Check the File Size box in the 

Performance Monitor window to determine when your file reaches 1MB. 
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11. On the Options menu, click Log. 

 
12. Click Stop Log. 
 
a. To display logged information 
 
1. On the View menu, click Chart. 

2. On the Options menu, click Data From.  The Data From dialog box 
appears. 

3. In the Data From dialog box , click the button with the ellipse(…) on it. 
The Open Input Log File dialog box appears. 

 
4. Click the lab1.log and then click Open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Data From dialog box appears , indicating data values will be displayed 
from your log file. 

 
5. Click OK. 
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6.   On the Edit menu, click Add To Chart. 
 

 
 

7. Using the information provided in the following table, click the following 
counters that become available for the Memory, Physical Disk, and 
Processor Objects. Click Add after each counter that you add. 

 
 

Object Counter Instance 
Memory Available bytes Not 

applicable 

Memory Pages/Sec Not 

applicable 
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Physical Disk %Disk Time 0 

Physical Disk Avg.Disk Bytes/Read 0 

Physical Disk Avg.Disk Bytes/Write 0 

Processor %Privileged Time 0 

Processor %Processor Time 0 

Processor %User Time 0 

 
 
The chart displays the information collected in your log. 
 

 
 
To create a report 
 
1. On the View menu, click Report. 

2. On the Edit menu, click Add to Report. The Add to Report dialog box 
appears. 

3. Using the information provided in the following table, click the following 
counters that become available for the Memory, Physical Disk, and 
Processor objects. Click Add after each counter that you add. 

 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  33 

Object Counter Instance 

Memory Available bytes Not 

applicable 

Memory Pages/Sec Not 

applicable 

Physical Disk %Disk Time 0 

Physical Disk Avg.Disk 

Bytes/Read 

0 

Physical Disk Avg.Disk 

Bytes/Write 

0 

Processor %Privileged Time 0 

Processor %Processor Time 0 

Processor %User Time 0 

 
4.   Click Done. 
 

 
 
The report displays the information collected in your log. 
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Lab - 4  (2 Real Time Hours) 
 

Event Viewer 
 
The event viewer is a utility in Windows NT that examines and manages the 
event log. There are three types of event logs. System log, Security log and 
application log. To start working with Event Viewer , do the following steps. 
 
1. Click on the Start Button. 

2. Click on the Program menu. 

3. Click on the Administrative Tools. 

4. Click on the Event Viewer utility. 

 
Windows NT displays the screen as shown in Fig. 
 

 
 

By default, the event viewer displays the system log events. The events that 
are significant to the components of the computer itself are recorded in the 
system log. For example , a hardware conflict is detected in the system, then 
the log of that event will be recorded in the system log. 

 
To view the application log events. 

 
5. Click on the Log main menu of the Event Viewer. 
 
6. Click on Application Log as shown in Fig.    
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NT displays a screen, where all events are displayed that get recorded when 
application are logged. In other words, the events are added when backup 
processes end. For example , an event is added to application when an alert 
condition is triggered, when NT repairs inconsistencies on the disk during 
process, the AUTOCHK program adds an event to this log when it is fixed.  
 
The Security log records the events based on the auditing settings that are 
specified in the User Manager for Domains.  By default, NT specifies the  ‘Do 
Not Audit’ option, which as a result no log get recorded in the security log. 
Only the administrator has the rights to view the security log. To view the 
security log first the audit option has to be configured, do the following steps: 

 
7. Open the User Manager for Domains. 
 
8. Click on the Policies main menu.             
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9. Click on the Audit… sub option as shown in Fig 
 
10. Select the Events as shown in Fig. 
 

 
 
11. Click on the OK button in the Audit Policy dialog box. 

12. Close the User Manager for Domains. 

13. Open the Notepad and try opening and closing one or more files in it. 

14. Close the Notepad. Click on the Event Viewer from the task bar. A sample 
screen of security log is shown in Fig. 

 

 
 

The details of each event can be viewed by double clicking the event.            
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Lab - 5 ( 1 Real time hours) 

 
Disk Administrator 
 
The most important part of Windows NT  is the disk storage space. The server 
administrator needs to organize the hard disk so as to divide it into partitions 
and volumes and make use of free disk space in the most efficient manner. 
 
Disk Administrator is a graphical utility that is used for administering your 
disk resources on an NT computer. As compared to DOS commands, it is a 
combination of CHKDSK, FORMAT and FDISK commands. 
 
The Disk Administrator provides the following functions. 
 
• Graphically displays the status of all the disks. 

• Create and Delete disk partitions. 

• Format, Label and assign drive letters to disk drives. 

• Scan disk and recover from errors. 

• Create and delete fault tolerance. 

• Create or extend volume sets. 

• Migrate disk configuration from one installation to another. 
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Navigating in Disk Administrator 
 
1. Click on the Start button. 
2. Click on the Programs menu. 
3. Click on Administrative Tools(Common) option. 
4. Click on Disk Administrator utility. 
5. Click on the OK button. 
 
NT displays another message window as shown in Fig , that the signature 
was not found. Signature is a logical sequence of disk drives , which is written 
by Windows NT before starting the disk administrator. This message does not 
appear for the next time. If you take the hard disk from one computer to 
another , NT will recognize it as it had made the signature on it in the 
previous machine. 
 
NT displays the Disk Administrator dialog box as shown in Fig. 
 

 
 
 

Creating a Logical drive 
 

1. Click in the Free space area. 
 

NT will enclose the free space with a rectangle indicating that the area has 
be 
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2. Click on the Partition main menu. 
 
3. Click on Create… option. 

 
NT displays a confirmation box as shown in Fig, for non-compatibility of 
the partition with MS-DOS. 

 

 
                    
4. Click on Yes button. 

 
NT displays the create primary partition dialog box as shown in Fig asking for 
the number of bytes you would like to keep in this partition i.e. the partition 
size. 

 
 

 
 
 



 
 
 
 
Operating Systems with Windows NT 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 40 
 

 
 
5. Type the partition size to the half of maximum size displayed. In this case, 

the total size is 4503 MB as such the partition size is taken as 2250 MB. 
   

 
                   
6. Click on the OK button.                   
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Notice that NT displays the created logical area as unformatted and assigns a 
drive letter as G: as shown in Fig. 
 
Before you proceed further, you will have to commit the change you have 
made, do the following steps to achieve it. 

 
7. Click on the Partition main menu. 
8. Click on Commit Changes Now option as shown in Fig.               

 
NT displays a confirmation box for saving changes as shown in Fig.                                           
 

 
9. Click on the Yes button. 
NT prompt you with a message dialog box confirming the changes saved as 
shown in Fig. 
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10. Click on the OK button. 

11. Right-Click on the F drive. A menu pops-up. 

12. Click on the Format option. NT displays the Format dialog box as shown 
in Fig. 

 

 
13. Convert the File system to NTFS and in the volume label; type 

“RADIANT_NTFS” as shown in Fig. 
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14. Click on the Start button in the Format window. NT displays the warning 
dialog box for data erase as shown in Fig. 

 

 
 
15. Click on the OK button. Notice that the formatting starts as it gets 

displayed in the last rectangle as shown in Fig.                                    
 

 
 

After the format is complete. Windows NT displays the complete dialog box 
as shown in Fig. 
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16. Click on the OK button. The F drive gets the volume label as you specified 
and it becomes highlighted to as that it was gray earlier indicating that the 
partition was not formatted. 

 
17. Close the Disk Administrator window by clicking the close button. 
 
18. Open Windows NT Explorer. Notice that one more drive has been added 

to your drive tree structure. 

 
                       
Creating and Extending Volume Sets 
 
Just as you can take one physical disk and divide it into separate partitions 
that each have a drive letter assigned to them, you can also create what is 
called a Volume set. A Volume set is a collection of free space areas of up to 32 
disks that can be assigned a single drive letter. The space gets used 
sequentially from one area to the next, but appears to the user or program as a 
single drive. You can use this to create logical disks that are larger than the 
one you usually have, or use it to reclaim deleted partitions and reuse them as 
larger volumes. 
 
To create a volume set, follow these steps: 

 
1. Select the first free space by clicking the graphical representation of it on 

the Disk Administrator Window. 
 

The New 
Directory 
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2. While holding down the Control key, click the next free space you want to 
add to the volume set. Continue holding down the Control key to keep 
adding more free spaces to the volume set. 

 
3. When you have finished selecting the spaces to be used to create the 

volume set, select the Partition | Create Volume Set. You will be asked to 
select the maximum size for the volume, based on the total available space 
in the free spaces 

 
4. Click on OK. 
To extend a volume set, follow these steps: 
 
1. Select the volume set first from the graphical display that you want to 

extend. Then using the Control key and by clicking on additional space, 
add to the volume set. 

 
2. From the pull-down Partition menu, select Extend volume set and then in 

the resulting window, choose the total size for the volume set. 
 
3. Click OK. 
 
To delete an area from a volume set, you must delete the volume set first. To 
delete a volume set, select it and then select Delete from the pull-down 
Partition menu. 
 
 

Lab - 6 (1 Real time hours) 
 
Printing in Windows NT Environment 
 
a. Adding a printer 

 
1. Log on as Administrator. 
2. Choose Start, Settings, Printers as shown in Fig. 
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3. Double-click on the Add Printer icon as shown in Fig. 
 

 
 
This displays the Add Printer Wizard as shown in Fig. 

 
4. Choose My Computer and click on Next button. 
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5. Select LPT1 from the Available Ports as shown in Fig and click on the Next 
button.                   

 

 
 
6. Select the manufacturer and printer as per your printer model and click on 

the Next button. 
 
Note :  By default the printer name you specified is displayed in the 

Printer Name dialog box. 
 
b. Sharing a printer                                        
 
1. Continue with the previous exercise. 
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2. Accept the Default Printer name and click on Next button.                      
 

 
3. A dialog box will be displayed prompting you to type the Printer  

4. Name is automatically filled but the user can also type the Printer Name. 

5. Do not change the name of the Printer.  

 

 
 

6. Click on Next button. 

7. Click on Shared option circle as shown  in Fig.                     
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8. Type the Printer name in the share name text box as shown in Fig. 

9. Click on Next button. 

10. Select the No radio button for not printing the test page as shown in Fig.                    

 

 
 
11. Click on the Finish button. 

 
This will copy printer files, create a printer and display the printer icon 
with a hand holding the icon.   
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Lab - 7 ( 1 Real Time Hours) 
 

Registry 
 

More Cautions About Editing the Registry 
 
If you are just learning about the Registry, you are probably eager to wade 
right in and modify a value entry. Before you do, however, let me just talk 
about using caution when manipulating the Registry. 
 
The vast majority of Registry items correspond to some setting in the Control 
Panel, Server Manager, User Manager for Domains, or the like. In general , 
don’t use the Registry to modify a value that can be modified otherwise. 
So a Question will arise , Why, then learn about the Registry Editor? Here are 
three reasons: 

 
 Some settings- importance ones- can be altered only with the Registry 

Editor, so there is no getting around the fact that an NT administrator has 
to be proficient with the Registry Editor. 

 
 You can use the Registry Editor to change system value entries on remote 

computers. Here is a simple example. You are in New York, and you want 
to change the background color on a server in Atlanta. One way to do so 
would be to get on a plane and travel to Atlanta to run the Control Panel 
on the NT machine at that location. A better way, however, would be to 
start up the Registry Editor, choose Registry|Select Computer, and edit 
the Registry of the remote computer. (This way assumes that you are 
running NT Server, and you have the security access to change the 
Registry of the remote computer: that is, you are a member of the 
Administrator group on that computer.) 

 
 A program called REGINI.EXE that comes with the Resource Kit enables 

you to write scripts to modify the Registry. Such a tool is quite powerful. 
You could write a REGINI script, for example, to reconfigure an NT setup 
completely. Again, however, before you start messing with that program, 
be sure that you have become proficient with the Registry. As explained 
earlier, you can get into all kinds of trouble when working with the 
Registry Editor. Imagine what kind of automated disasters you could start 
at 100MHx with a bad REGINI script! 
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Changing the Registry 
 
Step 1: Description 
 
This task enables the Administrator to change the Registry. 
Step 2 : Action 

 
1. To open the Registry Editor, choose Start|Run. 

 

 
2. In the command line, type REGEDT32 and press Enter. 

 
3. Click Window and choose HKEY_LOCAL_MACHINE. Maximize that 

window , and you see a screen somewhat like the one in Fig. 

 
 
4. Modify the value entry in HKEY_LOCAL_MACHINE\ Software\ 

Microsoft\WindowsNT\CurrentVersion. To do so, double-click the 
Software key and then double-click the Microsoft key. Next, double-click 
the Windows NT key, and finally , double-click the CurrentVersion key. 
You will see a screen as shown in Fig. On the left pane, you still see the 
Registry structure. On the right, you see the value entries in the 
RegisteredOrganization subkey.            
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5. Double-click RegisteredOrganization , and you see a screen like the one in 
Fig. 

 

 
 
6. Highlight the old value and replace it with Radiant Software Ltd . Click 

OK and then close the Registry Editor. 

7. Click Help and About for any program (even the Registry Editor will do), 
and you will see that your organization is now Radiant Software Ltd. 

8. By this task, you learned how to use the Registry to change the name of 
your organization. 

 
Altering Registry Data 
 
Poking around is not a desirable action or a time-saver, and this points out a 
glaring weakness of the Registry Editor: it has no effective search routine. 
Suppose you know that you have something called RegisteredOrganization, 
but you have no idea where it lives in the Registry. You are just out of luck. 
REGEDT32 includes a View/Find key, but you can use it to search only the 
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names of keys, not value entries. Because RegisteredOrganization is a value 
name within the keyCurrentVersion, you can search for it only when you 
know that the key’s name is CurrentVersion, which is not very likely. 
 
 
 
 
  
 
 
Searching for a key in the Registry Editor 
 
Step 1: Description 
 
This task enables the Administrator to find a key in the Registry. 
 
Step 2: Action 

 
1. Log onto the Windows NT server as Administrator. 
2. Choose Start|Run and type regedit32. You should see a Registry Editor 

similar to the one                  
 

 
  

3.  Choose View|Find key. 
 

You can use REGEDIT.EXE to search both key names and values. But don’t use 
this program because it might damage the Registry? You can use REGEDIT to 
view, but not edit, the Registry. This application displays the Registry as one tree 
and makes finding particular values easy , because it searches for partial 
matches. 
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4. In the Find box of the Find key dialog box, type the name of the key you 

want to find. 
 

5. If you want to restrict the scope of the search or define the search 
direction, select the Match Whole Word Only box , the Match Case option, 
or Up or Down in the Direction box. 

 
6. To see the next occurrence of the key name you specified , click Find Next. 
 
7. Click Find. Because key names are not unique, searching for additional 

occurrences of the key name you specified, click Find Next. 
 
8. Click Find. Because key names are not unique, searching for additional 

occurrences of a specific key name is a good idea, to ensure that you find 
the key you want. 

 
9. Working with the  Registry is a key system administration responsibility. 

Before you can alter any entry, you need to find the  entry. This task 
showed you how to find a key. 

 
10. Now that you have found the key, you can edit the value using the 

Registry Editor. 
 
Editing a key with the Registry Editor 
 
Step 1: Description 
 
This task enables the Administrator to edit a key in the Registry. 
Step 2: Action 
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1. In the right pane of the Registry Editor window , double-click the value 
entry, or from the Editor men, choose the String , Binary, Dword, or Multi 
String command as appropriate for the selected value. 

 
2. Edit the value that appears in the related Editor dialog box and then click 

OK. 
 

3. Working with the Registry is a key system administrator responsibility. 
This task showed you how to edit a value. 

 
Adding a key to the Registry Editor 
 
Step 1: Description 
 
This task enables the Administrator to add a key to the Registry. 
 
Step 2: Action 
 
1. Select the key or subkey under which you want the new key to appear. 

Then choose Edit|Add key , or press the Ins key. 
 
2. In the Key Name box of the Add Key dialog box, type the name you want 

to assign your key. The key name cannot contain a backslash(\). It must be 
unique in relation to other subkeys at the same level in the hierarchy; that 
is, Key1 and Key2 can each have a subkey named Key3, but Keyl cannot 
have two subkeys named Key3. 

 
3. Leave the Class box blank, as this entry is reserved for future use. 

 
4. Click OK to display the new key in the Registry Editor Window. 

 
5. This task showed you how to add a key to the Registry using the Registry 

Editor. 
 
Saving a Registry Key 
 
Step 1: Description 
 
This task enables the Administrator to save a Registry key. 
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Step 2: Action 
1. Select the key you want to save  as a hive file on a disk. 
 
2. Choose Registry|Save Key and then complete the filename information in 

the Save Key dialog box. Under the FAT file system, this filename cannot 
have an extension. When the key you are saving is the Registry of a remote 
computer, the drive and path you specify for the file name are relative to 
the remote computer. 

 
3. This task showed you how to save a Registry key using the Registry 

Editor. 
 
Restoring a Registry key 
 
Step 1: Description 
 
This task enables the Administrator to restore a Registry key. 
 
Step 2: Action 
 
1. Select the key where you want to restore the hive. 
 
2. Choose Registry|Restore and then complete the filename information in 

the Restore Key dialog box to specify the hive you want to restore. If you 
are running the FAT file system, this filename cannot have an extension. 
Also, when you are restoring a key on a remote computer, the drive and 
path of the filename are relative to the remote computer. 

 
 
 
 
3. This task showed you how to restore a Registry. You cannot restore keys 

or subkeys that have open handles. For this reason, you cannot restore the 
SAM or SECURITY subtrees (Windows NT always has handles open in 
these keys). You use the Restore command only for special conditions, 
such as restoration of user profiles on a damaged system. 

Backing Up and Restoring a Registry 
 
You might need to restore backed-up versions of Registry hives, for example, 
when you replace your current Windows NT computer, when a disk 

If you want to add a key temporarily to a system, use the Restore 
Volatile command. When you use this command , the Registry makes a 
volatile copy, which disappears when the system is restarted. 
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controller or hard disk goes bad, or when an electrical failure Zaps large parts 
of a disk. 
 
By now, you should understand that the Registry is important and should be 
protected. It protects itself pretty well with its LOG files, but how can you 
back it up? 
 
Unfortunately, the fact that Registry hive files are always open makes it tough 
for you to back up the Registry, because most backup utilities are stymied by 
open files. The NTBackup program that comes with NT works well, but it 
backs up to tape only. Nevertheless, if you use NTBackup – which is pretty 
good, particularly for its price- then you should tell it to back up the Registry 
every night. 
 
Outside NTBackup are a couple of other protection possibilities. A program 
named RDISK creates emergency repair disks. And the Resource Kit includes 
two useful utilities: the REGBACK.EXE program enables you to back up a 
Registry file, and the REGREST.EXE restore it. 
 
Backing Up Registry Hives 
 
You can back up Registry hives using one of the four methods. 

 
 Using a tape drive and the Windows NT backup program (NTBackup), 

select the Backup Local Registry option in the Backup Information dialog 
box to include automatically a copy of the local Registry files in the backup 
set. 

 
 If you don’t have a tape drive, run the REGBACK.EXE program from the 

Windows NT Resource Tool Kit, or use another tool that uses the same 
techniques to backup Registry files. 

 
 Start the computer under a different operating system. Then copy all files 

in the SystemRoot\SYSTEM32\CONFIG directory to a safe backup 
location. 

 
 Use the Save key command in the Registry Editor. This command 

essentially performs the RegBack procedure manually. 
 


